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Personnel and Equipment Safety Information
This section describes important safety information to avoid personal injury and 
damage to the equipment while establishing communication with the analyzer. The 
following Warnings also describe safety measures to follow while communicating with 
the analyzer to review or modify Calibration and/or Configuration parameters, or while 
performing maintenance on or troubleshooting the analyzer. All safety regulations, 
standards, and procedures at the analyzer location must be followed.

All personnel involved with the installation, start-up, operation, maintenance, service, 
or troubleshooting of the analyzer must review and follow these Warnings and Cau-
tions (below and in the analyzer manual).

Refer also to the analyzer manual for complete safety details on working with the ana-
lyzer, particularly in hazardous locations.

Warnings

Review and follow these Warnings to avoid personal injury or environmental contami-
nation.

Always disconnect main AC power and/or external power sources to the  
analyzer before opening any covers or doors on the analyzer and before re-
moving any components from the analyzer. 
 
If it is necessary to open the analyzer’s covers or doors while the circuits  
are live, test the area for flammable gases (and proceed only when the area  
is safe). 
 
When the Electronics Enclosure door is open, take appropriate precautions to 
avoid electrical shock. Hazardous voltages are present inside.

Contents  |  v
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About the System 200 Configurator Software

The System 200 Configurator Software provides a user interface to allow you to 
set up the 241CE II Hydrocarbon Analyzer and customize how data is viewed. 
While working from the Configurator Software, you can view real-time and 
historical data, and you can record and save data.

IMPORTANT 
Do not set up the Configurator Software to display internal water 
dewpoint or internal water content unless it is strictly for diagnostic 
purposes only. 
 
The internal water dewpoint and internal water content readings gen-
erated by the 241CE II Analyzer are not reliable alternatives to external 
outputs from devices such as the 3050-OLV Moisture Analyzer. 
 
AMETEK DOES NOT IN ANY WAY GUARANTEE THE INTERNAL WATER 
DEWPOINT AND INTERNAL WATER CONTENT READINGS GENERATED 
BY THE 241CE II ANALYZER.

Hazardous Locations 
Before working with the software, test the area around the analyzer for 
explosive gases and proceed only when the area is found to be safe. 
 
Do not connect the computer to the analyzer’s serial communication 
port and do not power up the computer if there is an explosive gas 
atmosphere present.
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Configurator Software Installation

The Configurator Software provides powerful features and flexible operating 
modes. Installing the Configurator Software consists of only a few steps and 
takes just a few minutes.

Minimum PC Requirements for Configurator 
Software

The Configurator Software requires the following:

•	 DVD drive (for installation).

•	 Pentium 166 or faster.

•	 16 MB RAM.

•	 3 MB of available hard disk space.

•	 Sound Card (for alarms) recommended, not required.

•	 Windows 7 Professional Edition and later. The System 200 Configurator 
Software is not certified to operate with Windows Home Editions.

•	 800 x 600 resolution or higher recommended.

•	 256-color display, 32767 colors (HiColor, 16-bit) recommended.
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Installing the Configurator Software

To install the Configurator Software on your computer:

1.	 Insert the Configurator Software DVD in the DVD drive. Navigate to the 
DVD drive, open the DVD, and double-click the 
 System200M241CEInstall.exe file. The software will begin the 
installation by displaying the Setup Wizard screen.

	 Click Next to continue. The Select Installation Folder screen will appear. 
By default, the software will be installed in C:\Program Files (x86)\
AMETEK\AMETEK M241CE Configurator. To install the software in a 
different folder, click Browse to view the Change current destination 
folder screen and navigate to the alternate folder. Select the folder and 
click OK.

	 Click Next to continue with the setup. The Ready to Install screen  
will appear.

Figure 1-1. 
Setup screens.







AMETEK recommends 
installing the software and 
program icons in the default 
directory.

AMETEK recommends 
having Admin Rights when 
installing this software 
(preferred but not required). 
Consult with your IT 
Administrator before installing 
the software.
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2.	 Click Install to initiate the setup. The software will install and the Setup 
Wizard “Finish” screen will appear. Click Finish and then remove the DVD 
from the DVD drive.

The software will create a shortcut icon on the desktop to start the 
software (called AMETEK M241CE Configurator).

	 To start the software, navigate to C:\Program Files (x86)\AMETEK\
AMETEK M241CE Configurator and double-click “M241.” Or, from the 
computer’s desktop, double-click the AMETEK M241CE Configurator 
icon.

	 For details about using System 200 Configurator Software to communicate 
with the analyzer, see “Starting the Configurator Software and Establishing 
Communication Between the Analyzer and Computer” in this chapter.

Figure 1-2. 
Setup Wizard Finish screen.
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Removing the Configurator Software

To remove the Configurator Software from your computer:

1.	 From the Windows Start menu, select Settings (  ) and then Apps.

2.	 Click Apps & features.

3.	 From the Apps & features list select AMETEK M241CE Configurator and 
click Uninstall to automatically remove it.

If any System 200 Software files remain in the C:\Program Files 
(x86)\AMETEK\AMETEK M241CE Configurator folder, delete all 
remaining folders and files.
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Configurator Software Overview

This section reviews the Configurator Software setup that is required to begin 
working with the software. Before beginning, you should have already in-
stalled and commissioned the analyzer as explained in the analyzer manual.

The general system configurations and calibration changes can be made after 
establishing communications with the analyzer and working from one main 
dialog box (M241 Properties, Figure 1-3). This dialog box contains numerous 
screens (tabs) that allow you to set up the analyzer and view live data.

Figure 1-3. 
M241 Properties dialog box 
(General tab).

Configurator Software Version
Check box selected

Analyzer Status field

Navigating in the Software and This Guide

While working with the software, the following rules apply:

•	 From the Setup tab (Figure 1-4) navigate to the various configuration and 
calibration screens by pressing the corresponding Setup Procedure button. 
For information about saving changes to these screens, see “Working From 
the Setup Tab” in Chapter 2.

	 If a button is greyed out, the function is not available. If all buttons are 
greyed out, the software is not communicating with the analyzer.

•	 To view live concentration values or information about the Optical Bench or 
analyzer, choose the Results and Status, History Data, Analyzer Data, or 
Record Data tab from the M241 Properties dialog box.

•	 To return to the Setup tab from any screen, click OK or Cancel.
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•	 Live values on the screens are updated at one-second intervals. When 
switching to a different screen, it may take up to one second for a new set 
of values to be displayed.

•	 While working with the software, use the following navigation buttons:

Press this button to view or close the Devices & Log window.

Press this button to start a new Custom Configuration mode.

Press this button to navigate to the computer’s hard drive to locate 
files, such as the Configurator file (“241 Datalog.dyc”).

Press this button to save the configuration data.

Press this button to print scanned data or save as a PDF file (such as 
Hydrocarbon Dewpoint Temperature values) from the analyzer.

While working with this guide, the following rules apply:

	 Reminder icon: 
The reminder icons in this guide indicate related information about 
the topic, certain actions that are necessary before continuing with the 
current procedure, or information that is recommended by AMETEK. 
See example at left.

	 Configurator Software navigation icon: 
The navigation icons in this guide indicate the menu structure to 
follow to view a menu, sub-menu, or analyzer information while 
working from the software.

	 In the example at left, after the Configurator Software is first started, 
the AMETEK Configurator main window will appear (Devices & Log 
window is active in this window). To initiate a Zero Calibration on the 
V-I Outputs, double-click Dev1 (<<Device Name>>) on the Devices & 
Log window to view the M241 Properties dialog box. From here, view 
the Setup tab and click the Command/Calibration button to view 
the Command and Calibration dialog box. Finally, if all requirements 
have been met to initiate the Zero, click the ZeroCal button.

•	 While working in this guide, the descriptions for all parameters in the 
Configurator Software that correspond with parameters seen while view-
ing the analyzer’s User Interface Panel (UIP) are included – along with 
the menu you can find it in – following the description, in brackets. For 
example, Baud Rate [ApplicCFG : Baud]. In this example, Baud Rate is the 
description seen in the Configurator Software, while “ApplicCFG : Baud” is the 
description seen on the UIP (where “ApplicCFG” is the menu in which the 
parameter – in this case, “Baud” – can be viewed or set up).

Example: 
AMETEK recommends 
installing the software and 
program icons in the default 
directory.

Example: 
AMETEK Configurator 
windowDev1 (Devices & 
Log window)Setup tab 
Command/Calibration dialog 
box <<ZeroCal button>>
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Figure 1-4. 
Navigating in the software, 
example.

Double-click Dev 1 (<< Device Name >>) 
to open the M241 Properties dialog box



Command/Calibration button 
(Setup tab) 

Zero Calibration button 
(Comment and Calibration dialog box)



Setup tab 
(M241 Properties dialog box)
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Starting the Configurator Software and 
Establishing Communication Between the Analyzer 
and Computer

You establish communication with the analyzer by using a computer running 
AMETEK’s Configurator Software.

Hazardous Locations 
Before connecting the serial cable between the analyzer and the com-
puter, take all necessary safety precautions and test the area around 
the analyzer for explosive gases and proceed only when the area is 
found to be safe. 
 
Do not open the analyzer enclosures and do not power up/down the 
analyzer or computer if there is an explosive gas atmosphere present.

To establish communication with the analyzer:

1.	 Connect the supplied serial communication cable between the computer 
and the RS-232 serial communication port (or Local Service Port, located 
at J106 on the Termination (Customer Connections) board inside the 
analyzer Electronics Enclosure).

2.	 An alternate (permanent) connection is via the RS-485 port (Remote Ser-
vice Port), located at J102 on the Termination (Customer Connections) 
board. See “Working From the Device Communication Tab” in Chapter 2 
and the analyzer manual for more information.

3.	 Power up the computer and start the Configurator Software using one of 
two methods:

•	 Navigate to C:\Program Files (x86)\AMETEK\AMETEK M241CE Con-
figurator and double-click “M241.”

•	 Click the AMETEK M241CE Configurator icon on the computer’s 
desktop.

	 The software will start and the Devices & Log window will appear in the 
AMETEK M241CE Configurator window (Figure 1-4). From the Edit menu, 
click Device Properties. The M241 Properties dialog box (General tab) 
will appear (Figures 1-3 and 1-4).

The M241 Properties dialog box is your main interface with the 
analyzer when viewing live data, or when modifying or viewing the 
analyzer’s configuration or calibration parameters.
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	 By default, Device Enabled and Live Data are enabled. When Live Data is 
enabled, the software automatically attempts to establish communication 
with the analyzer. If the communication attempt fails, the communication 
settings may be incorrect and/or the serial cable may not be connected 
properly (or it may be damaged), or you may be attempting to communi-
cate with the wrong of analyzer. Check the Status message and see “Con-
figurator Software Troubleshooting” for information about how to resolve 
communication problems.

4.	 Before continuing, you must set up the PC Communications parameters 
on the General tab of the M241 Properties dialog box to initialize com-
munications between the analyzer and the computer. To do this, click 
Setup to view the Communication Settings dialog box and select the ap-
propriate communication parameters (see “Working From the General Tab” 
in Chapter 2).

	 Click OK to initiate communication with the analyzer. The software will re-
vert to the M241 Properties dialog box (General tab, Figure 1-3) and the 
analyzer will be “Online” (view the analyzer Status field).

If at any time you close the M241 Properties dialog box (by click-
ing OK or Cancel), the software will revert to the AMETEK M241CE 
Configurator window. Return to the Setup Properties dialog box by 
clicking Edit and then Device Properties.

Closing the Configurator Software

Hazardous Locations 
Before proceeding, test the area around the analyzer for explosive 
gases and proceed only when the area is found to be safe.

After you are finished communicating with the analyzer, close the Configurator 
Software and disconnect the computer from the analyzer:

1.	 From the M241 Properties dialog box, click OK or Cancel.

2.	 From the AMETEK M241CE Configurator window, select File/Exit. Click 
Yes to exit the software.

3.	 Power down the computer and disconnect the serial cable from the ana-
lyzer’s RS-232 serial communication port.
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Configurator Software Troubleshooting

This section describes problems (alarms or “errors”) that may be encountered 
while attempting to establish communication between the analyzer and the 
computer, or when starting the software. Communication error messages can 
be displayed in the Status field on the General tab (Figure 1-3) and in the 
Devices & Log window (Figure 1-4; see also “Working From the Device Com-
munication Tab” in Chapter 2). If this window is not displayed in the M241CE 

Configurator main window, select View\Devices & Log or click    to 
display it.

If communication problems occur, review this section and perform the corre-
sponding corrective action to fix any problems.

Problem Encountered Corrective Action

The “Device Not Found” message is 
displayed if the system’s Communication 
Settings do not match the computer’s.

The Communication Protocol or Settings 
may be incorrect. Review the settings in the 
Communication Settings dialog box and 
verify or change them to the proper settings. 
See also “Working From the General Tab” in 
Chapter 2.

“Connected” is displayed on the Devices 
& Log window, but the software is not 
communicating with the analyzer.

Select Live Data (General tab) to establish 
communication.

“DEMO Online” is displayed in the Status 
field on the General tab if the PC is not 
connected to the analyzer or if Live Data is 
not selected (but Device Enabled is).

Select Live Data to establish communication.

“OFFLINE” is displayed in the Status field on 
the General tab.

Ensure both Device Enabled and Live Data 
(General tab) are selected to establish 
communication.

Check the serial cable for proper connections 
and for damage such as cuts, nicks, or burn 
marks. Also, check it to ensure the internal 
wiring is terminated at the connectors.

“DISABLED” is displayed in the Status field 
on the General tab. This message indicates 
the computer is connected to the analyzer 
but not communicating with it.

Select Device Enabled and/or Live Data, if 
necessary, to establish communication.

Device Properties under the Edit menu is 
greyed out (access to the M241 Properties 
dialog box is not available). If this occurs, 
the analyzer configuration and calibration 
parameters cannot be viewed or modified. 
This problem suggests that the  
“241 Datalog.dyc” file has become corrupt.

Delete the “241 Datalog.dyc” file from the 
C:\Program Files (x86)\AMETEK\AMETEK 
M241CE Configurator folder. The software 
will restore this file (and correct the problem) 
the next time it is started.
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Viewing, Configuring Analyzer Parameters and Data

Figure 2-1. 
General tab (M241 
Properties dialog box), and 
Communication Settings 
dialog box.

 Analyzer Information 
 message box



Select Setup to view the 
Communication Settings tab

Working From the General Tab

When the analyzer is connected to the PC, the current Host Controller Firm-
ware Version Number and analyzer Serial Number are displayed in the 
analyzer information message box to the right of PC Communications under 
the General tab. From this tab you can also set up communication parameters 
and device setup configuration that can be saved as a reference or restored to 
their original settings. The real-time communication Status is also displayed in 
this dialog box.

Viewing, Configuring Analyzer Parameters and Data  |  2-1PN 903-8599, Rev D
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Information and parameters on this screen include:

PC Communications 
Displays information that has been configured from the Communication 
Settings dialog box (accessed by clicking the Setup button):

Setup 
Allows you to select the communication settings required to establish 
communication with the analyzer.

Port is the COM port on the computer that will be used to communi-
cate with the analyzer. Default (typical) = COM1.

Baud [ApplicCFG : Baud] (system default) is the rate at which data will be 
transferred. The baud rate is fixed at 9600, and must be the same as 
the setting in the analyzer.

Port Type [ApplicCFG : Comm] RS-232 or RS-485, and must be the same 
as the setting in the analyzer: 

•	 Select RS-232 if using the analyzer’s Local Service Port (used 
with most applications).

•	 Select RS-485 if using the analyzer’s Remote Service Port. This 
is used for remote monitoring (i.e., such as through a control 
room) or if multiple analyzers are wired together on the same 
line (called a Multi-Drop system). Configure the RS-485 port 
from the Device Communication tab before selecting RS-485 
here. (See “Working From the Device Communication Tab” for 
more information.)

For more information about these service port connections, see the 
section titled “Configuring the Hardware for Digital Communication” 
in Chapter 2 of the 241CE II Hydrocarbon Dewpoint Analyzer User 
Manual.

Address [ApplicCFG : MB Addr] (system default) is the communications 
address of the analyzer. If the RS-232 port is selected, the address 
setting is not applicable (it is greyed out). If the RS‑485 port is se-
lected, be sure to enter a unique address for the analyzer.

2-2  |  241CE II System 200 Configurator Software 



Device

Name 
Enter a tag number or tag name.

Description 
Enter a description to further define the analyzer, such as a location or 
area where it is installed in the plant.

	 This can be useful if using a Multi-Drop system, where multiple analyz-
ers are wired together on the same line. In this case, you can assign 
different names and descriptions for each analyzer.

This information can be useful if using a Multi-Drop system, where 
multiple analyzers are wired together on the same line. In this case, 
you can assign different names and descriptions for each one.

Save Configuration button 
Saves the current analyzer configuration (operating) parameters to 
a file on the PC that can be used later to restore the settings. When 
you choose this button, the Save As dialog box will appear for you to 
name the file and select a path in which to save it. See “Saving Analyzer 
Configuration Parameters” for details about how to save configuration 
settings to a file.

Restore Configuration button 
Retrieves previously saved analyzer configuration (operating) param-
eters from a “.dev” file on the computer. When you choose this button, 
the Open dialog box will appear. This function can be used for configu-
ration recovery or after the EEPROM has been replaced. See “Restoring 
Analyzer Configuration Parameters” for details about how to restore 
configuration data to an analyzer.

Device Enabled
Checked (default)	 Allows communication with the analyzer, and 

allows the user to set up system configurations. 
If this parameter is not checked, device com-
munications are disabled.

Not Checked	 Device communication is disabled.

Live Data
Checked (default)	 Software uses live data from the analyzer. If this 

check box is not checked, the software will use 
demonstration data. 

Not Checked	 Software uses demonstration data.

Viewing, Configuring Analyzer Parameters and Data  |  2-3PN 903-8599, Rev D
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Analyzer Status field 
Displays the status of the analyzer (device) you are communicating with. 
See “Configurator Software Troubleshooting” in Chapter 1 for information 
about how to correct the problem.

•	 “OFFLINE” is displayed if the PC is not communicating with the system 
(one or both of the Device Enabled and Live Data check boxes are 
not selected).

•	 “Online” is displayed if the PC is communicating with the system (De-
vice Enabled and Live Data check boxes are selected).

•	 “DISABLED” is displayed if the PC is connected to the system but is not 
communicating with it (both the Device Enabled and Live Data check 
boxes are not selected).

•	 “Device Not Found” is displayed if the system’s Communication Set-
tings do not match the computer’s.

•	 “DEMO Online” is displayed if the PC is not connected to the system 
(or the Live Data check box is not selected and the Device Enabled 
check box is selected).

Configurator Software version  
Displays the version of Configurator Software running (located below the 
analyzer Status field.

2-4  |  241CE II System 200 Configurator Software 



User Interface

The software allows you to customize how data is viewed and to set up your 
display. This is done from the Main Window.

Setting Up Your Screen

Using the View menu items, set up your software by selecting the toolbars you 
want displayed. If the option has a check mark beside it, the toolbar is active. 
To toggle these functions on/off, select the menu option again. The areas that 
make up the Main Window include:

•	 Standard Toolbar
	 Contains icons that are used most often including the main display modes.

•	 Custom Mode Toolbar
	 Contains icons that are used to create Custom mode displays. See Chap-

ter 3 – Advanced Software Features.

•	 Data File Toolbar
	 Contains icons that are used to save data files.

•	 Status Bar
	 Located at the bottom of the window, the Status Bar displays system mes-

sages, including information such as if the system is currently scanning. For 
information on scanning, see Chapter 3 – Advanced Software Features.

Figure 2-2. 
Configurator Software main 
window (Trend mode display 
active).

Data File Toolbar

Main Window

Custom Mode Toolbar
Standard Toolbar

Status Bar
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Viewing Device Activities

The Devices & Log window displays the status of all analyzers (devices), plus 
a system event log of all analyzer operations. This window, which is displayed 
within the M241CE Configurator main window (Figures 1-4 and 2-3), can help 
you diagnose problems with the analyzer.

To display the Devices & Log window:

1.	 From the View menu, select Devices & Log or click   . A log is dis-
played showing all active devices and their status.

The system log is saved in a text file in the “Log” folder.

2.	 From here you can view a log of all related activity for active devices such 
as when scans were started or completed as well as any alarm conditions. 
It also provides information on the data source for the reading under the 
Source field (e.g., Dev1, or Device 1). The Status field indicates the current 
status of the analyzer (e.g., “Online”).

3.	 To remove the display, select View and then Devices & Log again or click  

 .

Figure 2-3. 
Devices & Log window.
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Saving Analyzer Configuration Parameters

The software allows you to save current analyzer (device) setup configura-
tion parameters to a file that can be used later as a reference or to restore the 
parameters to their original settings (if they are changed). This is useful to 
create a backup copy of the analyzer configuration parameters, or if you will be 
replacing the analyzer’s EEPROM.

If major changes are made to the analyzer configuration parameters, 
it is important to make a backup copy of these settings. This file can 
then be used to restore all parameters to their original (or latest) set-
tings in the event of an EEPROM failure or it being damaged physically 
or electrically.

To save configuration parameters:

1.	 View and record the following information to use as a reference after the 
software upgrade is complete:

a.	 Record the current version of the analyzer’s firmware from the User 
Interface Panel and from the Configurator Panel.

Record the version number from both locations and ensure they are 
an older version than that being replaced.

b.	 Record the current analyzer and software Modbus address settings 
from the User Interface Panel and from the Configurator Software.

Record the address settings from both locations as these settings must 
be restored later to allow communication between the analyzer and 
the Configurator Software or remote work station. 
 
While working from the UIP, also record the Comm type and Baud 
rate settings. While working from the Configurator Software, also 
record the Port, Baud rate, and Port type settings.

User Interface Panel: 
Status\History (menu)Right 
arrowM241 Vx.xx (where 
‘x.xx’ is the firmware version) 
 
 Configurator 
Software: 
General tab (M241 Properties 
window)view analyzer Status 
field (Vx.x)

User Interface Panel: 
ApplicCFG (menu)Right 
arrowMB Addr x (where ‘x’ 
is the Modbus address value) 
 
 Configurator 
Software: 
General tab (M241 Properties 
window)Setup button 
Address x (where ‘x’ is the 
Address value)
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2.	 From the General tab, click Save Configuration to view the Save As dia-
log box. To store the file, navigate to C:\ProgramData\AMETEK Configu-
rator\M241\data on the computer’s hard drive.

Figure 2-4. 
Save As dialog box  
(Save Configuration).

General (tab) 
<<Save Configuration>>

3.	 Name the file and click Save. The file will be saved with a “.dev” extension. 
This file can be used only by the Configurator Software. 

The procedure is complete.
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Restoring Analyzer Configuration Parameters

The Configurator Software allows you to retrieve previously saved analyzer 
configuration parameters to restore the parameters to their original settings. 
This function is useful if you wish to recover analyzer configuration parameters 
if changes have been made that you do not wish to keep, or to restore the set-
tings after replacing the analyzer’s EEPROM in the event of an EEPROM failure. 
The configuration parameters are stored in a “.dev” file on the computer.

To restore configuration parameters:

1.	 From the General tab click Restore Configuration to view the Open dia-
log box.

2.	 Navigate to the file (e.g., C:\ProgramData\AMETEK Configurator\M241\
data), select it, and click OK to restore configuration parameters to the 
analyzer you are communicating with.

	 During the parameters restoration, the analyzer will temporarily go 
“OFFLINE.” After the restoration is complete, the Name and Description 
will change to reflect those of the saved parameters.

General (tab) 
<<Restore Configuration>>

Figure 2-5. 
Open dialog box  
(Restore Configuration).

3.	 View the Devices & Log window. If the file restoration is successful, the 
message “This new CFG has been restored successfully!” will be dis-
played.

	 If the file that is being restored contains identical information as that 
already saved to the analyzer’s EEPROM, the message “The restored CFG is 
not new!” will be displayed in the Devices & Log window.

The procedure is complete.
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Working From the Device Communication Tab

The Device Communication tab contains the setup parameters specifically for 
the RS-485 Remote Service Port for the analyzer. These settings are necessary 
when the system is set up in a Multi-Drop configuration.

IMPORTANT 
If you need to set up the analyzer to communicate via the Remote 
Service Port, configure the settings on this tab first, then return to the 
Communication Settings dialog box (select the Setup button on the 
General tab) and select RS-485 Port.

Figure 2-6. 
Device Communication tab.

Baud Rate is the baud rate at which data will be transferred. The baud is fixed 
at 9600 (system default).

RS-485 Address is the communications address of the analyzer. If using 
multiple 241CE II Analyzers, be sure to enter a different address for each 
unit. After selecting an address for each additional analyzer, return to the 
Communication Settings dialog box and select RS-485 Port and the cor-
responding address.
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To set up the Remote Service Port (RS-485) communication parameters:

1.	 Ensure the device Status is “Online.” The Status message box should read 
“Online” (the Device Enabled and Live Data check boxes must be en-
abled).

2.	 From the Device Communication tab enter or select an address (a num-
ber between 0 and 239) for the analyzer in the RS-485 Address text field. 
You can either type a number in this box or use the arrows to select one.

3.	 The baud rate defaults to the fixed rate of 9600. There are no other op-
tions.

4.	 Click Apply and return to the General tab and select the Setup button to 
display the Communication Settings dialog box again.

	 Note that the address you entered in the Address text field in the Device 
Communication tab matches the Address setting in this dialog box.

5.	 Click RS-485 Port to enable the Remote Service Port. Click OK to save this 
change.

Check the Status of the system from the General tab again. It should 
now read “Online” if the communication port settings for both the 
analyzer and the PC are correct.

6.	 If the error message “Communication Failure. Do you want to start 
auto-detect?” appears, click No, then repeat Steps 2–5 and ensure the 
proper settings are made.

To check this, view the 
status of the system from the 
General tab.
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Working From the Setup Tab

The Setup tab contains all functional parameters that control the operation of 
the analyzer. Many of the parameters have been pre-configured at the factory, 
based on customer requirements and specifications. However, you will have to 
configure the communications settings to allow the analyzer to communicate 
with a PC via the Configurator Software.

The Setup screens and Configuration Parameters on this tab cannot be ac-
cessed if the system is “OFFLINE.” If the functions in this tab are greyed out, 
check the Status of the system from the General tab. You will have to establish 
communications with the analyzer before you can view or configure its param-
eters.

Figure 2-7. 
Setup tab.

 Instructions 
 message box

The setup procedures are grouped into the following categories, each with its 
own screen accessed by pressing one of the following buttons:

•	 Basic Setup

•	 Advanced Setup

•	 Command/Calibration setup

IMPORTANT 
For all first-time analyzer setups, the setup sequence of Basic Setup, 
Advanced Setup, and then Command/Calibration must be followed.
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While changing parameters from any of the setup screens, observe the follow-
ing functions and rules:

•	 After changing any of the parameters or their values from any setup 
screen, you must click the OK or Apply button on that screen (or within 
that group) to activate the new settings. These new settings will be sent to 
the analyzer.

	 If you click OK, the software will return to the Setup tab and will prompt 
with “Config parameters has been changed. Click the Save to Ana-
lyzer’s EEPROM button to save them (permanently) into the analyzer’s 
EEPROM” (displayed in the Instructions message box).

Parameters in groups that have their own Apply button cannot be 
reverted to their original state by clicking the Refresh button if the 
changes have already been applied.

•	 Any number of parameter values can be changed on a given screen before 
clicking the OK or Apply button.

•	 When you change parameters from the analyzer’s User Interface Panel, the 
new values will automatically be sent to the Configurator Software and the 
Refresh button on the Setup tab will flash to indicate a change has been 
made. To stop the Refresh button from flashing, click the Refresh button.

•	 On individual setup screens, click the Refresh button to change the values 
back to their original settings. When you click this button, any values that 
you have changed but do not wish to set permanently will revert to the 
settings that were last saved to the system’s EEPROM. Changes can only be 
refreshed if they haven’t already been applied (before you click the Apply 
button) or saved (before you click the Save to Analyzer’s EEPROM but-
ton).

•	 To permanently save the new value(s) to the analyzer’s on-board EEPROM, 
click the Save to Analyzer’s EEPROM button to the right of the message 
box.

•	 If you want the parameter changes to be valid only for the current session, 
do not click the Save to Analyzer’s EEPROM button. The changes will 
revert to the previously saved changes after the system is powered down 
and power is restored, or if the analyzer is reset.

•	 You can make changes to the Basic Setup, Advanced Setup, or Com-
mand/Calibration dialog boxes before clicking the Save to Analyzer’s 
EEPROM button.
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Setup Procedures consists of three buttons that provide different levels of 
setting up the analyzer. These buttons and their setup screens are dis-
cussed in detail in the following pages.

The Instructions Message box displays information to inform you if changes 
have been made to the system configuration, and how to permanently 
save them to the analyzer’s EEPROM.

The Save to Analyzer’s EEPROM button allows you to permanently save 
the new value(s) to the analyzer’s on-board EEPROM. This button is only 
displayed if changes to the configuration have been made. To save the 
changes, click this button.

Figure 2-8. 
Setup tab, with changed 
parameters to be saved to 
analyzer’s EEPROM.

 Instructions 
 message box
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Configuration Parameters allows you to perform general software opera-
tions.

•	 Click the Refresh button to change the values back to their original 
settings. When you click this button, any values that you have changed 
but do not wish to set permanently will revert to the settings that were 
last saved to the system’s EEPROM. Changes can only be refreshed if 
they haven’t already been applied (before you click the Apply button) 
or saved (before you click the Save to Analyzer’s EEPROM button).

•	 To print the 241CE II Analyzer configuration parameters that have been 
set up from the Setup tab to an ASCII file, click the Print to File button 
to view the Save As dialog box. Select the path you wish to save the 
file to, give the file a name, and then click Save to save the file. Note 
that the file will be saved with a “.dmp” extension.

•	 To print a hard copy of the existing analyzer configurations, click the 
Print button to view the Print dialog box. Make sure a printer is con-
nected to the PC or available through a network before printing the 
settings.
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Setting Basic System Configurations

The Basic Setup dialog box allows you to set up general system requirements, 
according to the options and functions for your application.

Figure 2-9. 
Basic Setup dialog box.

Setup (tab)Basic 
Setup

Basic System Configuration defines the basic setup of the analyzer and the 
parameters that will be displayed throughout the software.

•	 Units [MonitorCFG : Options – numerous selections for various parameters] allows 
you to select the measurement values in which you want your system 
data to be displayed (either Metric or Imperial).

•	 H2O Dewpoint Measurement allows you to select whether you want 
to display internal or external water dewpoint information, disable the 
water dewpoint function, or whether to display external water content 
information.

-	 Internal Dewpoint [H2O DP:INT – MonitorCFG menu] is available if you 
wish to view information about the 241CE II Analyzer’s internal 
water dewpoint measurements. Do not enable this parameter 
except for diagnostic purposes.

-	 Select Disabled [H2O DP:DISAB – MonitorCFG menu] (system default) if 
you wish to disable all 241CE II Analyzer’s water dewpoint mea-
surements. Typically, this option should be selected for normal 
operation unless the system is configured to receive an external 
water dewpoint signal.

	 When this option is selected, all options under H2O Content are 
disabled.
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-	 Select External Dewpoint [H2O DP:EXT – MonitorCFG menu] if you wish 
to view information about the external water dewpoint measure-
ment, which is calculated from the external water content mea-
surement. An optional, external water signal is required for this 
function to be enabled.

	 When this option is selected, all options under H2O Content are 
inactive and the options under Pressure Input Scales and Exter-
nal H2O Input Scales become enabled.

-	 Select External Content [H2O CT:EXT – MonitorCFG menu] if you wish to 
view information about the external water content measurement.

	 When this option is selected, all options except N/A under H2O 
Content are enabled. The options under Pressure Input Scales 
are disabled, while the options under External H2O Input Scales 
are enabled when this option is selected.

•	 H2O Content allows you to further define the setting you have selected 
from the H2O Dewpoint Measurement options. If the option is greyed 
out, it is not available for the H2O Dewpoint Measurement option you 
selected.

-	 N/A is available if you do not want to further define the internal water 
dewpoint measurements. This option is active only if Internal Dew-
point is selected. Do not enable this parameter except for diagnos-
tic purposes.

-	 Select Weight/Volume if you want to further define the water content 
measurements. When this option is selected, the External H2O Input 
Scales options become active, allowing you to define the low and high 
settings measured by the external water input signal. This option is 
enabled only if External Content is selected.

-	 Select ppmv [PMV – MonitorCFG : Options] if you want to display the water 
content in parts per million, by volume. This option is enabled only if 
External Content is selected.

-	 Select ppmw [PMW – MonitorCFG : Options] if you want to display the water 
content in parts per million, by weight. This option is enabled only if 
External Content is selected.
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Mirror LED Detection Setup allows you to define parameter thresholds 
for conditions that will trigger warnings caused by mirror-related 
problems. The parameters can be set separately for the hydrocarbon 
side and the water side of the measuring mirror. Note that the water 
side is the internal water dewpoint measurement. Based on these 
thresholds being exceeded, the appropriate LED on the analyzer’s User 
Interface Panel will turn on, or warning messages will be displayed on 
the Result and Status tab.

•	 Mirror LED Levels is the parameter that sets the LED brightness in the 
water [MonitorCFG : WLED] and/or hydrocarbon [MonitorCFG : HCLED] optics 
circuit. It can be any value between 0 and 4095, which represents a 
drive-current range of 0 to 50 mA. This is a factory-set parameter. Do 
not adjust this setting unless instructed to do so by an AMETEK 
Service Representative.

•	 Mirror Surface Drift Warning is the maximum change in the water 
[MonitorCFG : WMWarn] and/or hydrocarbon [MonitorCFG : HCMWarn] photo-
transistor signal at the end of two consecutive purge stages that can 
occur before the Dirty Cell primary status code alarm is output. This 
value is displayed as a percentage (%).

•	 Detection 1st Trigger Levels is the variable specifying the low thresh-
old of the increasing water [MonitorCFG : WTrg1] and/or hydrocarbon [Mon-

itorCFG : HCTrg1] phototransistor signal. This is a factory-set parameter. 
Do not adjust this setting unless instructed to do so by an AMETEK 
Service Representative.

•	 Detection 2nd Trigger Levels is the variable specifying the high 
threshold of the increasing water [MonitorCFG : WTrg2] and/or hydro-
carbon [MonitorCFG : HCTrg2] phototransistor signal. This is a factory-set 
parameter. Do not adjust this setting unless instructed to do so by 
an AMETEK Service Representative.

Pressure Input Scales allows you to define the absolute pressure correspond-
ing to the zero output (4 mA, Low [MonitorCFG : PLo]) or the full-scale output 
(20 mA, High [MonitorCFG : PHi]) of the pressure transmitter feeding into 
the 241CE II Analyzer. This function is enabled when you select External 
Dewpoint from the H2O Dewpoint Measurement group. This value is 
displayed in kPa or PSI. (System default = -1.0. This value disables this func-
tion.) These inputs are currently not used.

	 V/I #4 pressure output scales are used only if the user-selectable V/I type 
is set to Continuous Cell Pressure or Track-and-Hold Cell Pressure used in 
water content calculations.

	 To disable the pressure measurements, enter a negative value – such as 
1.0 – to the Low scales when you select External Dewpoint from the H2O 
Dewpoint Measurement group.
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External H2O Input Scales allows you to define the Low and High input 
ranges for water dewpoint measurements. This function is enabled only 
when you select External Dewpoint or External Content from the H2O 
Dewpoint Measurement group.

•	 Low [MonitorCFG : ExLo] is the minimum water dewpoint temperature 
or content corresponding to the 4 mA output from the low-scale of 
the external water dewpoint device. This input is assigned to the first 
analog output.

•	 High [MonitorCFG : ExHi] is the full-scale water dewpoint temperature 
or content corresponding to the 20 mA output from the low-scale of 
the external water dewpoint device. This input is assigned to the first 
analog output.

Serial Number is for AMETEK factory use only. Do not attempt to change the 
Serial Number. The Update button is also for factory use only.

Click the OK button to send the changes you made to the parameters on 
this tab to the analyzer. The changes will take effect upon normal system 
operation.

Click the Cancel button to discard any changes you made to the parameters 
on this tab. The original settings will remain upon normal system opera-
tion.

Click the Refresh button to change the values back to their original settings. 
When you click this button, any values that you have changed on the 
active tab will revert to the original settings (that were last saved to the 
system’s EEPROM).

	 The Refresh button will flash to indicate a change has been made from the 
analyzer’s User Interface Panel. To update the new changes in the Con-
figurator Software (and stop the Refresh button from flashing), click the 
Refresh button.
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Setting Advanced System Configurations

The Advanced Setup dialog box allows you to configure additional param-
eters for the 241CE II Analyzer.

Figure 2-10. 
Advanced Setup dialog box.

Setup (tab)Advanced 
Setup

Off-Spec Alarm Setpoints allows you to enter a value (under Alarm Set-
points) at which the Off-Spec alarm will be triggered when the system 
determines that the existing output is greater than the alarm set point. 
Depending on the selections in the Basic Setup tab (H2O Dewpoint Mea-
surement group), some of these options may not be enabled. The Current 
Output is a real-time display of the temperatures for H2O Dewpoint (if 
used) [ApplicCFG : WDPA], HC Dewpoint [ApplicCFG : HCDPA], and H2O Content (if 
used) [ApplicCFG : WCA].

Cell Purge Duration [ApplicCFG : Purge] allows you to set the length of time for 
the system’s Cell Purge, in minutes (0–255).

User Selectable Relay [ApplicCFG : UsrRelay] allows you to select the condition 
that energizes alarm relay four (4).

•	 Select No Dewpoint Found to energize the alarm relay when one or 
both dewpoints are not found [NoD].

•	 Select Purge in Progress to energize the alarm relay when the ana-
lyzer is in the Purging/Hold Stage [Pur].
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End-of Run Type [ApplicCFG : RunType] allows you to select the condition which 
will determine when the Cooling Stage will be terminated.

•	 Select Low Temperature to terminate the Cooling Stage when the 
mirror temperature reaches the Low set point temperature [LowT] or, 
if after two minutes, the Thermoelectric Cooler has been unable to 
reduce the mirror temperature any further.

•	 H2O Dewpoint Found is available if you wish to terminate the Cooling 
Stage when the internal water dewpoint temperature has been found. 
Do not enable this parameter except for diagnostic purposes.

•	 Select HC Dewpoint Found [HCDP] (system default) to terminate the 
Cooling Stage when the hydrocarbon dewpoint temperature has been 
found.

•	 Both Dewpoints Found is available if you wish to terminate the Cool-
ing Stage when both the internal water dewpoint and the hydrocar-
bon dewpoint temperatures have been determined. Do not enable 
this parameter except for diagnostic purposes.

Dewpoint Offset Compensation Coefficients are system-dependent, factory-
configured parameters and cannot be changed. These values are greyed 
out to ensure they cannot be changed.

Mirror Temperature allows you to set up the analyzer to control operations 
based on various mirror parameters.

•	 The Current Output is a real-time display of the mirror temperature. 
This value cannot be modified.

•	 The Setpoints High [ApplicCFG : MTHi] and Low [ApplicCFG : MTLo] text 
fields allow you to enter a value for the maximum and minimum mirror 
temperatures of which the analyzer will warm up and cool down to. 
Operating temperatures that exceed the maximum or fall below the 
minimum will cause a system alarm.

•	 The Cooling Rates Fast [ApplicCFG : FRate] and Slow [ApplicCFG : SRate] text 
fields allows you to enter a value in which the Cooling Stage will cool 
the mirror, measured in degrees/minute (°C/min or °F/min). Fast is the 
Fast per minute cooling rate and Slow is the Slow per minute cooling 
rate.

•	 Temp. above last Higher dewpoint to switch cooling rate  
[ApplicCFG : Above] allows you to enter a value in which the analyzer will 
switch the Cooling rate from the Fast rate to the Slow rate.

•	 Conversion Coefficients are system-dependent, factory-configured 
parameters and cannot be changed. These values are greyed out to 
ensure they cannot be changed.
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Click the OK button to send the changes you made to the parameters on 
this tab to the analyzer. The changes will take effect upon normal system 
operation.

Click the Cancel button to discard any changes you made to the parameters 
on this tab. The original settings will remain upon normal system opera-
tion.

Click the Refresh button to change the values back to their original settings. 
When you click this button, any values that you have changed on the 
active tab will revert to the original settings (that were last saved to the 
system’s EEPROM).

	 The Refresh button will flash to indicate a change has been made from the 
analyzer’s User Interface Panel. To update the new changes in the Con-
figurator Software (and stop the Refresh button from flashing), click the 
Refresh button.

2-22  |  241CE II System 200 Configurator Software 



Setting System Command and Calibration Configurations

The Command and Calibration Setup dialog box allows you to set up pa-
rameters for V-I outputs and to initiate a manual purge. This dialog box also 
includes a button to reset the 241CE II Analyzer. Additionally, this dialog box 
includes system diagnostic controls and parameters (typically reserved for 
trained AMETEK personnel only).

Setup (tab) 
Command/Calibration

Figure 2-11. 
Command and Calibration 
dialog box.

 Message box

V-to-I output allows you to define and calibrate up to four V/I outputs, labeled 
Channel # 1–4.

Channel # (1–4) parameters may be enabled (and some may vary), de-
pending on your system’s configuration. Channel # 1 is reserved for 
Water Dewpoint, # 2 is for Hydrocarbon Dewpoint, # 3 is for Water 
Content, and # 4 is for Continuous Cell Pressure (or SCode).

Enter a value in the appropriate channel for the associated parameter.

•	 Enter a value in the Low Scale text field [ApplicCFG : I1L,I2L,I3L,I4L] to define 
the low scale of the corresponding output range.

•	 Enter a value in the High Scale text field [ApplicCFG : I1H,I2H,I3H,I4H] to define 
the high scale of the corresponding output range.
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•	 Enter a value in the Zero (mA) text field [MonitorCFG : I1Z,I2Z,I3Z,I4Z] to define 
the real-time output value corresponding to the low scale (4.00 mA). This 
value will be calibrated using the Zero Cal button, described below.

•	 Enter a value in the Span (mA) text field [MonitorCFG : I1S,I2S,I3S,I4S] to define 
the real-time output value corresponding to the high scale (20.00 mA). This 
value will be calibrated using the Span Cal button, described below.

•	 Assignment of Channel 4 [ApplicCFG : UsrVI] allows you to select a User V/I 
type.

-	 Select Status Code (system default) [SCode] to configure Channel 4 to 
output SCode. Its Low/High rates are fixed at 0/255.

-	 Select Pressure Output [Prs] to configure Channel 4 to output a 
continuous pressure value from the pressure transmitter. This input is 
currently not used.

-	 Select Track-and-Hold Pressure Output [T&HPrs] to configure Chan-
nel 4 to output the Track-and-Hold pressure value. The Track-and-Hold 
function holds the pressure during the Purging/Hold Stage of the 
measuring cycle. This input is currently not used.

•	 After the analog V-I outputs have been set up, click the Normal button to 
turn on the V-to-I outputs to their normal operating mode.

•	 Click the Mid-Scale button to verify the mid-scale value for each channel.

•	 Click the Zero Cal button to calibrate the Zero output current against the 
zero value you entered for each channel. For example, if the Zero current 
output is higher than 4.00 mA, decrease the zero value in the Zero (mA) 
text field until the Zero output current moves to precisely 4.00 mA.

•	 Click the Span Cal button to calibrate the Span output current against the 
zero value you entered for each channel. For example, if the Span current 
output is higher than 20.00 mA, decrease the zero value in the Span (mA) 
text field until the Span output current moves to precisely 20.00 mA.

•	 Click the Apply button to save the changes you made to the parameters in 
this group and send them to the analyzer.
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Diagnose Mode

•	 Click the Diag. Mode button to switch the analyzer’s diagnostics func-
tion On/Off. Typically this should be On only when you wish to initiate 
a manual purge. Before resuming normal analyzer operations, be sure 
to switch this function Off.

•	 Set Alarm LEDs allows you to set the status of the seven alarm LEDs 
on the User Interface Panel in binary code (0 = LED Off, 1 = LED On). To 
set each one, click each of the numbered buttons 1–7 to switch them 
between ‘0’ and ‘1’. View the LEDs on the User Interface Panel to verify 
they turn On and Off. Typically reserved for factory diagnostics or 
trained AMETEK personnel only.

•	 Click the Cooler Control button to switch the analyzer’s cooler con-
trol function On/Off. The cooler control voltage is displayed in the mV 
text field during normal operation. This value can be changed during 
system diagnostics. Typically reserved for factory diagnostics or 
trained AMETEK personnel only.

•	 Click the Cell Purge button to initiate a manual purge. The cell purge 
will continue until you click this button again to turn it Off. Typically 
reserved for diagnostic testing of the solenoid circuit.

•	 The Optical Paths settings allow you to change the LED Drive values 
(in mV) for the water and hydrocarbon LEDs in the Measuring Cell. 
The Mirror Light message boxes indicate the real-time values from 
each phototransistor. Typically reserved for factory diagnostics or 
trained AMETEK personnel only.

•	 Click the Apply button to save the changes you made to the param-
eters in this group and send them to the analyzer. Typically reserved 
for factory diagnostics or trained AMETEK personnel only.
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Temperature Calibration displays the real-time temperature of the mirror, 
as measured by a RTD within the analyzer’s Measuring Cell Assembly. This 
parameter is reserved for trained AMETEK service personnel only. Do not 
change this parameter without authorization and instructions from 
authorized AMETEK personnel.

•	 To set this parameter, enter a value in the New Value text field. The 
real-time temperature of the mirrors is displayed directly above the 
New Value text field.

•	 Click the Apply button to update the existing temperature to the new 
value. Changing the Temperature Calibration value is not recommend-
ed. If you click this button, the message “Don’t click on OK unless you 
have entered a correct new value.” will appear. Click Cancel to avoid 
saving any changes (including the ‘0’ value that is the default).

The message box below the Temperature Calibration settings provides 
instructions on command buttons used in the software program, including 
“Clear Alarm”, “Off-Spec”, and “Save to EEPROM.”

Click the OK button to send the changes you made to the parameters on 
this tab to the analyzer. The changes will take effect upon normal system 
operation.

Click the Cancel button to discard any changes you made to the parameters 
on this tab. The original settings will remain upon normal system opera-
tion.

Click the Refresh button to change the values back to their original settings. 
When you click this button, any values that you have changed on the 
active tab will revert to the original settings (that were last saved to the 
system’s EEPROM).

	 The Refresh button will flash to indicate a change has been made from the 
analyzer’s User Interface Panel. To update the new changes in the Con-
figurator Software (and stop the Refresh button from flashing), click the 
Refresh button.

Click the Reset M241 button to reset the analyzer without turning off the main 
power breaker to the system. When you click this button, a confirmation 
dialog box appears to prompt you to continue with the system reset. Click 
OK to reset the analyzer or click Cancel to abort the reset.

Click the User Driver button when you wish to turn on the analyzer’s spare 
relay output. This function is only available if a spare relay out is used with 
your application.
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Working From the Result and Status Tab

The Result and Status tab allows you to view live data results of the selected 
outputs, plus the Fault and Warning conditions associated with the Status 
Code (SCode) and Extended Status Code (XSCode). You can also enable or dis-
able the Off-Spec alarms and clear all alarms from this tab. This dialog box is 
particularly useful when performing diagnostics on the analyzer.

Figure 2-12. 
Result and Status tab.

System Status Messages along the top portion of this screen display informa-
tion about the Configurator Software and the analyzer.

•	 The Status message box displays the communication status between 
the Configurator Software and the analyzer. Messages that can appear 
here include: OFFLINE, Online, DISABLED, Device Not Found, or 
DEMO Online. Their descriptions are listed under “Working From the 
General Tab.”

•	 Runtime [Run menu : RT or Stat\History menu : T] is displayed next to the Sta-
tus message box. The Runtime is the amount of time the Configurator 
Software has been running since it was last powered up or reset.

•	 The 241CE II Analyzer Firmware version [Run and Stat\History menu] is 
displayed next to the Runtime message (for example, M241 R3.40). 
This information will be displayed only if the Configurator Software is 
communicating with the analyzer.
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•	 The 241CE II Analyzer Serial Number [Run and Stat\History menu] is dis-
played next to the Configurator Software version. This information will 
be displayed only if the Configurator Software is communicating with 
the analyzer.

•	 The Purge (Countdown) Time [Run menu : PTime or ApplicCFG : Purge] is 
displayed below the Runtime, indicating the amount of time remain-
ing in the current Purging/Hold Stage. This parameter will only be 
displayed while a Purging/Hold Stage is in progress.

Status Code [Stat\History menu : SCode] conditions box displays the various Status 
Code alarm conditions (either Fault or Warning), their descriptions and/or 
suggestions of all active alarms. The sum of their respective primary codes 
is listed in the message box next to Status Code. The alarm types, their 
descriptions, and their primary codes are listed in Figure 2-13. A Warning 
indicates that the analyzer may require servicing. A Fault, however, indi-
cates that a fault has occurred and the analyzer data are not valid – the 
analyzer requires immediate attention.

Primary 
Code Type Condition / Suggestion

0 — No Warnings or Faults.
1 Warning w TimeOut [Stage-Time-Out]. Review XSCode for more 

information.
2 — Not Used
4 Warning w No HC DP [Hydrocarbon-Dewpoint-Temperature-Not-

Found]
8 Warning w Check XSCode [Advice – Review-Extended-Status-Code]

16 Warning w Dirty Cell [Possible-Cell-Contamination]
32 Fault f H2O Optics [Problem-In-Water-Side-Optical-Path] – This 

is an internal alarm; it is not related to the external wa-
ter dewpoint signal (if used). 
 
Review XSCode for more information.

64 Fault f HC Optics [Problem-In-Hydrocarbon-Side-Optical-Path] 
 
Review XSCode for more information.

128 Fault f Cool Cct [Problem-In-Cooling-Circuit]

Figure 2-13. 
Operating Status Code 
(SCode).
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Ext. Status Code [Stat\History menu : XSCode] conditions box displays the vari-
ous Extended Status Code alarm conditions (either Fault or Warning) and 
their descriptions and/or suggestions of all active alarms. The sum of their 
respective primary codes is listed in the message box next to Ext. Status 
Code. The alarm types, their descriptions, and their primary codes are 
listed in Figure 2-14.

Primary 
Code Type Condition / Suggestion

0 — No Warnings or Faults.
1 Warning w EEP Warn [End-Of-EEPROM-Life]
2 Warning w Hold TimeOut [Purging/Hold-Stage-Time-Out]
4 Warning w Cool TimeOut [Cooling-Stage-Time-Out]
8 Warning w Warm TimeOut [Warming-Stage-Time-Out]

16 Warning w Cross Talk [Excessive-Mirror-Cross-Talk]
32 Warning w High DP [Hydrocarbon-Dewpoint-Temperature-Too-High] 

– HCDP temperature is within 5 °C (9 °F) of the measuring 
cycle start temperature.

64 Fault f High Temp [Mirror-RTD-Temperature-Is-Too-High]
128 Fault f Low Temp [Mirror RTD-Temperature-Is-Too-Low]
256 Fault f H2O Dim [Light-Intensity-On-Water-Side-Is-Too-Low] – 

This is an internal alarm; it is not related to the external 
water dewpoint signal (if used).

512 Fault f HC Dim [Light-Intensity-On-Hydrocarbon-Side-Is-Too-Low]

The Cycle Stage message box [Run menu : Stage] displays the operating stage of 
the analyzer: 
COOL = Cooling Stage 
WARM = Warming Stage 
HOLD = Purging/Hold Stage

The Mirror Temp. message box [Run menu : MTemp] displays the real-time tem-
perature of the mirror.

The Temp Trend message box displays the real-time trend of the mirror 
temperature, either rising (UP), falling (DOWN), or static (LEVEL). The Temp 
Trend message will change according to the trend of the mirror tempera-
ture.

The DP Found message box displays the status of the dewpoint temperature 
measurement, which depends on the analyzer settings, HC FOUND or NOT 
FOUND either (H2O FOUND and BOTH FOUND are not used).

Figure 2-14. 
Extended Status  
Code (XSCode).
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The H2O Mirror Lite message box [Run menu : WMir] displays the real-time level 
of light being reflected from the water side of the mirror within the Mea-
suring Cell Assembly. This is an internal parameter; it is not related to 
the external water dewpoint signal (if used).

The HC Mirror Lite message box [Run menu : HCMir] displays the real-time level 
of light being reflected from the hydrocarbon side of the mirror within the 
Measuring Cell Assembly.

The Calculated Results – located to the right of the Status Code and Ext. 
Status Code conditions boxes – displays the existing results and values. 
The value for each result will be displayed and updated at one-second 
intervals.

	 If there are no alarms present, its name, result (value), and unit type will be 
displayed in Black text. If there is a Warning alarm present, it will be dis-
played in Yellow text. If there is a Fault alarm present, it will be displayed in 
Red text.

	 If you press the Clear Alarm button to clear the existing alarms, the pa-
rameter will change back to Black (to indicate no related alarms are pres-
ent).

	 Depending on the H2O Dewpoint Measurement selection from the Basic 
Setup dialog box, certain parameters will be displayed here:

•	 H2O Dewpoint [Run menu : WDP] and its real-time value is displayed if 
External Dewpoint is selected from the H2O Dewpoint Measure-
ment group from the Basic Setup dialog box.

•	 HC Dewpoint [Run menu : HCDP] and its real-time value is displayed at 
all times, regardless of which H2O Dewpoint Measurement option is 
selected from the Basic Setup dialog box.

•	 H2O Content [Run menu : WCT] and its real-time value is displayed if 
External Content is selected from the H2O Dewpoint Measurement 
group from the Basic Setup dialog box.

•	 Pressure [Run menu : Prs] and its real-time value is displayed if External 
Dewpoint is selected from the H2O Dewpoint Measurement group 
from the Basic Setup dialog box.
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Alarm LEDs displays the results of the seven Alarm LEDs that were set under 
the Diagnose Mode group in the Command and Calibration Setup dia-
log box. These LEDs, located on the User Interface Panel, switch On/Off to 
indicate alarm status in binary code (0 = LED Off, 1 = LED On).

Click the Off-Spec Alarm button [Stat\History menu : En\Dis Alrm?] to enable or dis-
able the Off-Spec Alarm function. When you click this button, the message 
beside LED 1 in the Alarm LEDs group will change to read “1 - Over-limit 
alarms are disabled” or “0 - Over-limit alarms are enabled.” The Off-Spec 
alarm conditions and descriptions are displayed to the left of the Off-Spec 
Alarm Enabled button. The Off-Spec alarms that are detected by the ana-
lyzer will be indicated by corresponding alarm LEDs on the analyzer’s User 
Interface Panel.

	 When the Off-Spec alarms are enabled, the relay output of the Off-Spec 
alarms will be enabled; otherwise, they will be disabled.

Click the Clear Alarm [Stat\History menu : Clear Alarm?] button to clear all exist-
ing alarms in the Status Code or Extended Status Code, plus all Off-Spec 
alarms, too. Any alarms that have been detected by the analyzer and dis-
played in the Status Code and/or Ext. Status Code conditions boxes will be 
reset and removed from these boxes.
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Working From the History Data Tab

The History Data tab provides a history of results/data and SCode/XSCode 
alarms recorded by the 241CE II Analyzer, up to a maximum of nine for each 
result/data and SCode/XSCode. The real-time values for all data are also listed 
on this screen. No changes can be made to this screen.

This dialog box is useful when performing diagnostics on the analyzer. As the 
message in the message box at the bottom of the screen indicates when you 
first enter this screen, you can click on any of the Basic Status Code or Extend-
ed Status Code numbers as they scroll by to view the associated Warning or 
Fault alarm associated with that code.

The message “Click on any Scode/Xscode data, the corresponding 
error code will be decoded and shown here.” is only displayed the 
first time you visit this screen.

Figure 2-15. 
History Data tab.
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The information that is displayed on the screen depends on the option se-
lected from the H2O Dewpoint Measurement group in the Basic Setup 
dialog box.

The Current status of the enabled parameters and their historical data are dis-
played to the right of the parameters. Depending on the H2O Dewpoint 
Measurement selection from the Basic Setup dialog box, certain parame-
ters and their real-time status and history will be enabled or disabled here:

•	 Run Time (sec, min,…) displays the total amount of time the Configu-
rator Software has been running since it was last powered up or reset. 
This parameter is always displayed. The real-time values indicate days, 
hours, minutes, and seconds (for example, 01  04:27:33, indicates 1 day, 
4 hours, 27 minutes, and 33 seconds).

•	 Basic Status Code [Stat\History menu : ^SC] displays the sum total of all 
Status Codes. This parameter is always displayed.

•	 Extended Status Code [Stat\History menu : ^XSC] displays the sum total of 
all Extended Status Codes). This parameter is always displayed.

•	 Dewpoint Found displays the status of the dewpoint temperature, 
either H2O (not used), HC, BOTH (not used), or NOT. This reading de-
pends on the analyzer settings. This parameter is always displayed.

•	 H2O Dewpoint [Stat\History menu : ^WD] displays the temperature at 
which the water dewpoint was found. This display is enabled and will 
indicate water dewpoint if External Dewpoint is selected from the 
Basic Setup dialog box.

•	 HC Dewpoint [Stat\History menu : ^HCD] displays the temperature at 
which the hydrocarbon dewpoint was found. This parameter is always 
displayed.

•	 H2O Content [^WC (Stat\History menu)] displays the water content read-
ings. This parameter is enabled and will display water content if Exter-
nal Content is selected from the Basic Setup dialog box.

•	 Pressure [Stat\History menu : Pw] displays the pressure reading from the 
pressure transmitter (if used). This input is currently not used.

•	 Max. Pressure [Stat\History menu : Px] displays the maximum pressure 
reading found from the pressure transmitter (if used) during the last 
nine cooling stages. This input is currently not used.

•	 Min. Pressure [Stat\History menu : Pn] displays the minimum pressure 
reading found from the pressure transmitter (if used) during the last 
nine cooling stages. This input is currently not used.
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•	 H2O Mirror Start Light [Stat\History menu : ^WMir] displays a light signal 
from the water-side phototransistor at the start of the Cooling Stage. 
This parameter is always displayed. This is an internal parameter; it is 
not related to the external water dewpoint signal (if used).

•	 HC Mirror Start Light [Stat\History menu : ^HCMir] displays a light signal 
from the hydrocarbon-side phototransistor at the start of the Cooling 
Stage. This parameter is always displayed.

The History readings display the recorded values for each of the parameters 
during the last nine Cooling Stages. Depending on the H2O Dewpoint 
Measurement selection from the Basic Setup dialog box, certain parame-
ters and their real-time status and history will be enabled or disabled here.

To back out of this screen or to view or set up other system informa-
tion, choose another tab. Clicking OK or Cancel will take you back to 
the Initial Start-Up screen. You will have to re-establish computer-
analyzer communications.
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Working From the Analyzer Data Tab

The Analyzer Data tab allows you to view the real-time status of all settings 
made to the 241CE II Analyzer. No changes can be made to this screen. The 
parameters included on this tab are described below.

Figure 2-16. 
Analyzer Data tab.

V-I Analog Output displays the output values for each of the analog output 
parameters. Depending on the H2O Dewpoint Measurement selection 
from the Basic Setup dialog box, certain parameters will be displayed 
here:

•	 H2O Dewpoint and its real-time value is displayed if the External 
Dewpoint option is selected from the H2O Dewpoint Measurement 
group from the Basic Setup dialog box.

•	 HC Dewpoint and its real-time value is displayed at all times.

•	 H2O Content and its real-time value is displayed if External Content 
is selected from the H2O Dewpoint Measurement group from the 
Basic Setup dialog box.

•	 Scode or Pressure is displayed at all times, depending on which H2O 
Dewpoint Measurement option is selected from the Basic Setup dia-
log box.
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Scaled Analog Input displays the input information for the analog inputs as-
sociated with the analog channels used by this system. Depending on the 
H2O Dewpoint Measurement selection from the Basic Setup dialog box, 
certain parameters will be displayed here:

•	 Channel # 0 will display AIN (Analog Input) Pressure and its real-time 
value if the External Dewpoint option is selected from the H2O Dew-
point Measurement group from the Basic Setup dialog box (and if an 
external water signal is supplied).

•	 Channel # 4 will display the External Water Dewpoint (Ext H2O DP) 
and its real-time value if External Dewpoint is selected from the H2O 
Dewpoint Measurement group from the Basic Setup dialog box. If 
External Content is selected, this channel will display the External 
Water Content (Ext H2O CT) and its real-time value.

•	 Channel # 5 displays the real-time reading for the Hydrocarbon Mirror 
Light (HC Mirror Light).

•	 Channel # 6 displays the real-time reading for the Mirror Tempera-
ture.

•	 Channel # 8 displays the real-time reading for the Water Mirror Light 
(H2O Mirror Light). This is an internal parameter; it is not related 
to the external water dewpoint signal (if used).

Raw Analog Input displays the input information for the raw analog inputs 
for each of the analog channels used by this system. Some of the displayed 
parameters are dependant on the H2O Dewpoint Measurement selection 
from the Basic Setup dialog box. N/A indicates the analog channel is not 
available (not used).

•	 Channel # 1 displays the input signal from the Pressure Transmitter 
(Pressure). Optional, if used.

•	 Channel # 2 is not used. The description for this raw analog input will 
read N/A (not available).

•	 Channel # 3 is not used. The description for this raw analog input will 
read N/A (not available).
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•	 Channel # 4 will display the External Water Dewpoint (Ext H2O DP) 
and its real-time value if External Dewpoint is selected from the H2O 
Dewpoint Measurement group from the Basic Setup dialog box.

	 If External Dewpoint is selected from the H2O Dewpoint Measure-
ment group from the Basic Setup dialog box, this channel will display 
the External Water Content (Ext H2O CT) and its real-time value.

	 If the optional Remote Start function is used, this channel will display 
the Remote Start and its real-time value.

•	 Channel # 5 displays the real-time reading for the hydrocarbon mirror 
light (HC Mirror Light).

•	 Channel # 6 displays the real-time reading of the Mirror Tempera-
ture.

•	 Channel # 7 is not used. The description for this raw analog input will 
read N/A (not available).

•	 Channel # 8 displays the real-time reading for the water mirror light 
(H2O Mirror Light), regardless of which option is selected from the 
H2O Dewpoint Measurement group from the Basic Setup dialog 
box. This is an internal parameter; it is not related to the external 
water dewpoint signal (if used).

EEPROM Writes [Stat\History menu : EEP WR] displays the number of times con-
figuration changes have been made and saved to the analyzer’s EEPROM. 
Each time a change is made and saved, the number in this display box will 
increase by one. A maximum of 20,000 changes are required before a the 
EEPROM will need to be replaced.
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Mirror Temperature Control displays a variety of information about the ana-
lyzer’s mirror cooling.

•	 Cooler State displays the On/Off status of the analyzer’s Thermoelec-
tric Cooler during the Cooling Stage.

•	 Cooler Control displays the real-time reading (in mV) of the Thermo-
electric Cooler during the Cooling Stage.

•	 Trend displays the real-time trend of the mirror temperature, either 
rising (UP), falling (DOWN), or static (LEVEL).

•	 Temperature displays the real-time reading of the mirror during the 
Cooling Stage.

Alarm LED Code displays the On/Off status of the seven alarm LEDs on the 
User Interface Panel in binary code (0 = LED Off, 1 = LED On).

Driver Output displays On/Off status of the purge.

To back out of this screen or to view or set up other system informa-
tion, choose another tab. Clicking OK or Cancel will take you back to 
the Initial Start-Up screen. You will have to re-establish computer-
analyzer communications.
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Working From the Record Data Tab

The Record Data tab allows you to receive live record data from the analyzer. 
To use this function, communications between the computer and the analyzer 
must already be established. If communications have already been estab-
lished, the record data collected during the last Cooling Stage will be displayed 
in the main data area. At this point, it can be saved to a file. Or, you can enable 
the Auto-Save feature to allow continuous saves of subsequent record data 
following each Cooling Stage.

Figure 2-17. 
Record Data tab.

To save existing record data:

1.	 If the record data has already been updated on the screen, the Save Cur-
rent Record as button will be enabled. Click this button to save the record 
data that you see on the screen. A standard Save As dialog box will ap-
pear.

	 If the record data is still being collected, the Save Current Record as but-
ton will be greyed out (disabled) until the record data has been saved, at 
the end of the current Cooling Stage.

2.	 In the Save As dialog box, enter a name for the file and select the path 
where you will save the record data. The default file name and extension is 
RData.csv. You can change this name to something more descriptive.
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To enable the software to auto-save the record data:

1.	 Click the Start button to begin saving the record data in a series of files 
that correspond to subsequent Cooling Stages. A standard Save As dialog 
box will appear.

2.	 Enter a name for the file and select the path where you will save the record 
data. The default file name and extension is RData.csv. You can change 
this name to something more descriptive. The software will attach a serial 
number to the filename automatically when saving the record data (for 
example, RData1.csv, RData2.csv, RData3.csv, etc.).

3.	 Click OK to start the recording. The Start button will become greyed out 
and the Stop button will become enabled, to allow you to stop the record-
ing. The message “Starting …” will be displayed.

4.	 The record data file will save to the path you selected. It is a good idea to 
save the files to the DATA folder so you will be able to easily locate them.

5.	 The Auto-Save function will run in the background, during normal analyzer 
operations. The automatic recording will continue until you click the Stop 
button.

6.	 You can now view the files using Microsoft Excel.
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Advanced Software Features

While working with scanned data, you can use the Mode menu or the toolbars 
to select different modes and their configuration parameters. The different 
modes allow you to set up your preference on how to view the analyzer data.

Figure 3-1. 
Trend mode display active.

Data File Toolbar

Main Window

Custom Mode Toolbar
Standard Toolbar

Status Bar

The software also provides advanced software features, such as graphing and 
scanning data, and saving the data to files that can be viewed at a later date. 
Details of how to set up and view analyzer information in this format is de-
scribed in the following pages.
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•	 While working with the advanced software features, use the following 
toolbar icons:

Press this button on the Standard Toolbar to create an array of 
Meter mode windows, or on the Custom Mode Toolbar to add a 
Meter mode display to a Custom mode window.
Press this button on the Standard Toolbar to create an array of 
Annunciator mode windows, or on the Custom Mode Toolbar to add 
an Annunciator mode display to a Custom mode window.
Press this button on the Standard Toolbar to create an array of 
Trend mode windows, or on the Custom Mode Toolbar to add a 
Trend mode display to a Custom mode window.
Press this button on the Standard Toolbar to create an array of 
Tabular mode windows, or on the Custom Mode Toolbar to add a 
Tabular mode display to a Custom mode window.

 
Press this button on the Standard Toolbar to create a Custom mode 
display window. 

Other toolbar icons used with the advanced software features are 
discussed in the following pages for the specific software function.

•	 While working with advanced software functions, use the following tools: 

Standard Toolbar 
Includes various tools (icons) that can be used while working with 
modes and scanning data. This toolbar includes standard mode display 
tools.

Custom Mode Toolbar 
This toolbar includes custom mode display tools.

Data File Toolbar 
This toolbar includes tools that are used while scanning and working 
with files and mode displays.

Main Window 
Displays the standard mode and custom mode display mode windows 
with live data, as configured by the user.

Status Bar 
Displays system messages, including information such as if the system 
is currently scanning.

More information about these tools is included in the descriptions for 
the various mode displays in the following pages.
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Introduction to the Modes of Operation

Any settings you define for a mode will be retained by the system when you 
change to a different mode or exit the program.

Any display or scan parameters that you define for a mode will not be trans-
ferred to a new mode when you switch modes. However, the system will con-
tinue to scan when you change modes.

The available modes are listed in the following pages.

Creating a Meter Mode Display

Meter mode allows you to view information in a meter-type format. Alarms can 
be set up and displayed on the meter to view the current reading in relation 
to the High and Low alarm Limits defined. You can also define unique Scan, 
Display, and Alarm output settings.

Figure 3-2. 
Meter mode display.
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While working in Meter mode:

•	 Each meter has a bar representing a measured value. Text under the meter 
displays the numeric value of the measured parameter.

•	 Each meter can be set to display alarm limits. As long as the measured 
value is within the High and Low alarm Limits, the meter bar appears in 
GREEN.

	 A YELLOW meter bar indicates an alarm Warning condition.

	 A RED meter bar indicates an alarm Fault condition.

•	 Any other actions associated with alarms are activated if the limit is ex-
ceeded (e.g., running an information file, or setting off a digital or analog 
output).

•	 Before changing meter properties, you must select the meter by clicking 
on it. The meter will be highlighted with a YELLOW border when selected 
(active).

To set up a Meter mode display:

1.	 Select Meter from the Mode menu or click    from the Standard Tool-
bar.

2.	 Click a meter to select it.

3.	 Right-click the active meter and define the Scan, Display, and/or Alarm 
settings for the meter.

4.	 Repeat Steps 2 and 3 to add more meters.
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Creating a Annunciator Mode Display

Annunciator mode allows you to track whether a measured parameter is 
within acceptable user-defined limits using a simple color/text indication.

Figure 3-3. 
Annunciator mode display.

If the level is:

	 WITHIN the alarm limits defined 	 = 	 GREEN	 =	 OK
	 ABOVE the High alarm warning level	 = 	 YELLOW	 =	 HIGH
	 ABOVE the High alarm limit 	 = 	 RED	 =	 HIGH
	 BELOW the Low alarm warning level 	 = 	 YELLOW 	 =	 LOW
	 BELOW the Low alarm limit 	 = 	 RED	 =	 LOW

	 You can set up multiple indicators, each corresponding to a different  
gas species. You can also define unique Scan, Display, and Alarm output 
settings.
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While working in Annunciator mode:

•	 Annunciator mode is normally used to define alarm limits so that you can 
view – using visual indicators – whether the selected value is within the 
alarm limits.

•	 For each channel, a GREEN display indicates the value is within acceptable 
limits.

	 A YELLOW display indicates an alarm Warning.

	 A RED display indicates an alarm Fault condition.

•	 Before changing the display properties, you must select the display by 
clicking on it. The display will be highlighted with a YELLOW border when 
selected (active).

To set up an Annunciator mode display:

1.	 Select Annunciator from the Mode menu or click    from the Stan-
dard Toolbar.

2.	 Select a display by clicking on one.

3.	 Right-click the active display and define the Scan, Display, and/or Alarm 
settings for the display.

4.	 Repeat Steps 2 and 3 to add more displays.
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Creating a Trend Mode Display

Trend mode allows you to view trends of measured parameters in a graphical 
format. You can also define unique Scan, Display, and Alarm output settings.

While working in Trend mode:

•	 The main Trend mode window displays each channel as a colored line. The 
Y-axis displays partial pressure or measured value; the X-axis displays time.

•	 You can view the exact value of a trend line by holding down the left 
mouse button in the trend graphical display area. Display the Data File 
Toolbar to view the time of each data point.

•	 Before changing the display properties, you must select the display by 
clicking on it. The display will be highlighted with a YELLOW border when 
selected (active).

Figure 3-4. 
Trend mode (graph) display.
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To set up a Trend mode graph:

1.	 Select Trend from the Mode menu or click    from the Standard Tool-
bar.

2.	 Select a display by clicking on one.

3.	 Right-click the graph and define the Scan, Display, and/or Alarm settings 
for the graph.
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Creating a Tabular Mode Display

Tabular mode allows you to view information in a textual, table-type format. 
You can also define unique Scan, Display, and Alarm output settings. Finally, 
you can perform Dynamic Data Exchange (DDE) functions with Tabular mode 
display data.

Figure 3-5. 
Tabular mode display.

While working in Tabular mode:

•	 If an alarm was defined and the alarm has been exceeded, an alarm indica-
tor will appear to the right of the main table.

•	 You can copy any of the columns from a Tabular display window to the 
clipboard. See also “Copying Magnitudes” and “Copying Channels” below 
for more information.

•	 Before changing the display properties, you must select the display by 
clicking on it. The display will be highlighted with a YELLOW border when 
selected (active).
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To set up a Tabular mode display:

1.	 Select Tabular from the Mode menu or click    from the Standard 
Toolbar.

2.	 Select a display by clicking on one.

3.	 Right-click the active display and define the Scan, Display, and/or Alarm 
settings for the display.

4.	 Repeat Steps 2 and 3 to add more displays.

Copying Magnitudes

You can copy any of the columns from a Tabular mode display window to the 
computer’s clipboard.

1.	 Right-click on the Tabular mode display and select Copy Magnitudes. 
This places the Dynamic Data Exchange (DDE) data onto the clipboard.

2.	 Select Paste Special from the Edit menu to create the DDE link and con-
tinuously update the data in real time.

Copying Channels

1.	 Right-click on the Tabular mode display and select Copy Channels. This 
places the name of the channel onto the clipboard.

2.	 Select Paste Special from the Edit menu to create the DDE link and con-
tinuously update the channel names in real time.

If you are importing data into Microsoft Excel, select Preference from 
the Edit menu. See “Setting Preferences” for more information.
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Setting Preferences

The Preferences dialog box allows you to set up parameters that define how 
Tabular mode files will be saved.

Figure 3-6. 
Preferences dialog box.

Edit menu 
Preferences

To set preferences, select Preferences from the Edit menu.

•	 DDE Item Separator 
Select the character that will separate multiple data items in a Dynamic 
Data Exchange (DDE) message:

Return 
Select this to place the numbers into separate columns.

Tab 
Select this to place the numbers into separate rows.

Space 
Select this to place the numbers on the same line but separated by 
spaces.

•	 Trend Colors 
Set the default trend channel colors.

•	 Data file size 
Set the maximum size for a data file. This can be an integer between ‘1’ and 
‘16’. The normal value is ‘1’ megabyte. Setting the data file size to a higher 
value will increase the size of your data files as well as the size of the trend 
graph buffer. As a result of this increase, it will require more disk space and 
memory.
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Creating a Custom Mode Display

Custom mode allows you to create custom setups that can include all Scan-
ning, Display, and Alarm output options. This is done from the Set Custom 
Mode Menu dialog box. Custom mode setups can include either a single 
mode display window or multiple mode display windows. Using Custom 
mode, you can create a unique display by mixing and matching the best fea-
tures of various modes.

For example, you can customize the window to show one Meter mode display 
window, one Trend mode display window, and two Annunciator display win-
dows. Or, you could set up two Trend mode display windows, or two Tabular 
mode display windows.

Three default custom mode setups are included with the Configurator Soft-
ware and more can be added as needed. For each display window added in 
Custom mode, the Scan, Display, and Alarm output options are set as if in 
that specific mode.

For example, if adding a Meter mode window within the Custom mode, all set-
tings for that window are defined as if in Meter mode.

To create a Custom mode:

1.	 Select New from the File menu or click    on the Standard Toolbar.

2.	 Select Add Display from the Edit menu and select the type of display 
you want to add from the list of standard mode types. Or, use the Custom 
mode icons on the Custom Mode Toolbar to add different displays.

3.	 Specify the data source. Select the applicable source of data from the Data 
Source group by clicking Device and then selecting the device you want 
to enable.

Figure 3-7. 
Set Custom Mode Menu dialog 
box.
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4.	 Repeat Steps 2 and 3 to add others displays, if desired.

Figure 3-8. 
Custom mode display, with 
Meter, Annunciator, Tabular, 
and Trend modes all in one 
display.

5.	 Select Save As from the File menu to save the Custom mode. Or click one 

of the    icons on the Standard Toolbar to save the Custom 
mode to one of the predefined Custom mode file names (custom1.dyc, 
custom2.dyc, or custom3.dyc). Custom mode files are given a .dyc file 
extension.

6.	 To retrieve the Custom mode file at a later time, select Open Configura-
tion from the File menu. If you used one of the predefined icons, double-
click one of the files to retrieve it.

Moving or Resizing a Window in Custom Mode

Select the mode display window to move or resize. The window is highlighted 
with a YELLOW border.

•	 To move the window click, hold, and drag it to its new location then re-
lease the mouse button.

•	 To resize the window, use standard Windows methods.
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Adding a Display Window in Custom Mode

1.	 From the Edit menu, select Add Display. Choose the type of display win-
dow to add.

2.	 Select the data source for the display window.

3.	 The system adds a display window to the Custom mode window.

Deleting a Window in Custom Mode

1.	 Click on the window to be deleted. The window is highlighted with a 
YELLOW border.

2.	 Select Delete Display from the Edit menu, press the Del key on the key-

board, or click    from the Custom Mode Toolbar to delete the display 
window.

Saving Custom Mode Files

1.	 Select Save As from the File menu . You can save the Custom mode setup 
under a new name or use one of the predefined icons.

2.	 Select the Save button to save the file.

3.	 By default, the system places these files in the folder where the Configura-
tor Software is installed and gives the file a .dyc extension.

If you save a Custom mode file in the install folder with the name “startup.dyc” 
it will automatically be opened when the program starts.

Opening Custom Mode Files

1.	 Select Open Configuration from the File menu or click    from the 
Standard Toolbar.

2.	 Navigate to the location of the Custom mode file to open.

3.	 Select the Custom mode file and click Open.
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Adding Custom Mode Files to the Mode Menu

1.	 Select Set Menu from the Mode menu to view the Set Custom Mode 
Menu dialog box (Figure 3-7). From this window you can associate a 
Custom mode file to a menu selection on the Mode menu, which will 
allow you to quickly access the file at any time. You can also customize 
the Menu/Button Name of the Custom mode file that will appear on the 
Mode menu. Default names are “Custom1”, “Custom2”, “Custom3.”

2.	 To do this, click the Browse button and navigate to the location of the 
Custom mode file(s).

	 If desired, enter a customized name in the Menu/Button Name text field. 
This name will appear on the Mode menu for quick access.

	 To remove a Custom mode file from the Mode menu, leave the Menu/But-
ton Name text field blank. The file will still remain in the folder but will not 
be displayed on the menu.

3.	 To recall any of these files, click one of the    icons on the Stan-
dard Toolbar, or select the corresponding menu from the Mode menu.
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Defining Scan, Display, and Alarm Parameters for 
the Different Modes

This section describes how to set up data to scan, configure how it will be dis-
played, and how to set up alarm limits and actions for certain parameters.

Scanning Data

You can use the Configurator Software to scan analyzer data or link data from 
a different display. Data that is scanned can be displayed on the screen in any 
of five formats (or modes) based on your application. See “Introduction to the 
Modes of Operation” and “Setting Up the Display Parameters” for information 
about setting up modes and defining their parameters.

A configuration file has been included with the Configuration Soft-
ware.

From the File menu, select Open Configuration to open the  
241 DataLog.dyc file. This should be in the same directory in which the Con-
figurator Software has been installed. This configuration file sets up the soft-
ware to display data of:

•	 Trend graph of Hydrocarbon Dewpoint.

•	 Hydrocarbon Mirror phototransistor signal.

•	 Mirror Temperature.

•	 Cooler Temperature.

Once the file is open, click    on the Standard Toolbar to start scanning 
data.
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Defining Scan Settings

You can define the type of information to gather from the selected device. To 
do this, right-click on the desired display window and click Scan to display the 
<<Mode>> Properties dialog box (Scan tab active).

For Trend and Tabular modes you must first select a channel before 
you can define scan settings. To do this, select a Channels button.

Data Source
	 Select the Device (analyzer name) from which to scan or temporarily dis-

able the scanning device.

•	 Disabled 
Select this to disable the output of the signal assigned to the selected 
channel from being displayed.

•	 Device 
Select this and use its list box to select the Device from which data will 
be scanned.

Figure 3-9. 
Scan properties setup screen.
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•	 Link from 
Data can be linked from one window into another. This can save scan-
ning time since the system only needs to scan the data one time. To do 
this:

1.	 Select the display window that will receive the linked data from 
another data source.

2.	 Right-click over the display window and click Scan.

3.	 From the Data Source group, select the Link from button.

4.	 Under the Link from list box select the data source to link from.

Starting a Scan

To start a scan, click    or select Scan from the Control menu. The message 
“Scanning” and the scanning progress will appear in the Status Bar at the bot-
tom of the window (if it has been enabled).

If you have scheduled scans at timed intervals and the system has finished 
a scan and is waiting to start the next scan, the time remaining (seconds or 
minutes) before the start of the next scan is displayed (e.g., “Idle - Next scan in 
00:10.”

“Idle” is displayed in the Status Bar when the system is not scanning.

Stopping a Scan

Click    or select Scan from the Control menu to toggle off the scan.
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Scheduling Scans

Scheduling scans allows you to choose the type of scan to be performed and 
the scan interval.

To schedule the scan, select Schedule from the Control menu or click    on 
the Standard Toolbar to view the Schedule dialog box.

Single Scan radio button 
Select this to command the software to run a single scan when you click  

 . The system will stop scanning after one scan.

Continuous radio button 
Select this to command the software to run scans at timed intervals when 

you click   .

Scan Interval text field 
Type a number to specify the time delay between successive scans. This 
value is further defined by the selection of Seconds or Minutes.

Figure 3-10. 
Schedule Scan dialog box.
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Setting Up the Display Parameters

Setting Display parameters allows you define information about how the 
selected signals will be displayed in the various modes.

This section applies to all modes, except where noted.

To set up the Display parameters for a mode, right-click on a display window 
and click Display to view the Properties dialog box (Display tab active). For 
modes using channels – Trend and Tabular modes – you must first select a 
channel before you can define the scan settings.

Figure 3-11. 
Display Properties dialog box.

Title 
Type the title for the display window. The name will appear in the title bar 
for that mode display window and in other areas of the software to identify 
the display window.

Autoscale check box (Meter mode only) 
When selected, the system automatically sets the Y-axis based on the high-
est value from the previous scan. This will also override the Y-axis. As the 
highest peak increases or decreases, the display scale is changed to accom-
modate the changing highest peak.
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Logarithmic check box (Trend and Meter modes only)
Checked	 The software uses a logarithmic scale to display 

readings.

Not Checked	 The software uses a linear scale to display read-
ings.

Upper limit (Trend and Meter modes only) 
This value is used only when the Autoscale check box is not checked. 
Enter the upper limit to display on the Y-axis.

Lower limit (Trend and Meter modes only) 
This value is used only when the Autoscale check box is not checked. If 
Logarithmic is selected, use this text field to enter the number of logarith-
mic decades to display on the Y-axis using the upper limit as the top of the 
display range. If Logarithmic is not selected, enter a value into this text 
box for the Lower limit.

Units 
 This is the value in which your results will be displayed.

•	 In the Units text field, type in the units of which you want the scanned 
information displayed.

•	 Precision 
Defines the number of digits after the decimal point to be shown. For 
example, if the precision is set to ‘2’, a reading might be 5.22.

Channel name (Trend and Meter modes only) 
Names the displayed channel. Select one of the Channels buttons and 
enter a name for it in the Channel name text field.

Channel color (Trend mode only) 
Defines a different color for the displayed channel. A custom color can also 
be chosen by clicking on the Custom button and selecting a color.

Minutes (Trend mode only) 
Applies to Trend mode only. Defines the time interval to include on the 
display.

Display Values (Trend mode only) 
If checked, displays channel values in Trend mode.

Hide check boxes (Trend mode only) 
If checked, the data channel will not be displayed but will continue to track 
the data. This is useful when viewing a scan that overlaps another scan.
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Setting Alarm Parameters

Setting Alarm parameters allows you define information about how the se-
lected signals will be displayed in the various modes.

To set up the Alarm parameters for a mode, right-click on a display window 
and click Alarm to view the Properties dialog box (Alarm tab active).

The alarms discussed in this section are used by the Configurator Soft-
ware only. They are not the same as the concentration alarms on the 
analyzer. The analyzer concentration alarms operate independently of 
the Configurator Software.

This section applies to all modes, except where noted.

For Trend and Tabular modes, first select the channel as the source of the 
alarms before you define the Alarm values. Setting alarms includes defining 
alarm limits and defining the actions that should be taken when an alarm limit 
is reached. Alarm limits also appear on the main display for the current mode. 
High and Low Limit alarms appear in RED; High and Low Warning alarms ap-
pear in YELLOW.

Figure 3-12. 
Display Properties dialog box.
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Enable all alarms

Checked	 Enables all High and Low alarms.

Not Checked	 Deactivated – alarms can be deactivated when, 
for example, your system is not operating.

High Limit 
When checked, enables the High Limit alarm.

Name	 Enter a name for the alarm that will be used to identify the 
alarm to the system.

Value	 Enter the high (upper) limit value for the alarm.

Count	 Defines the number of consecutive readings that must be 
above the High alarm Limit before the alarm is triggered. 
Higher count values decrease the possibility that a tran-
sient or noise signal will trigger a false alarm.

High Warning 
When checked, enables the High Warning alarm.

Name	 Enter a name for the alarm that will be used to identify the 
alarm to the system.

Value	 Enter the high (upper) limit value for the alarm. Must be 
lower than the High alarm Warning value.

Count	 Defines the number of consecutive readings that must be 
above the High alarm Warning limit before the alarm is 
triggered. Higher Count values decrease the possibility 
that a transient or noise signal will trigger a false alarm.

Low Limit 
When checked, enables the Low Limit alarm. 

Name	 Enter a name for the alarm that will be used to identify the 
alarm to the system.

Value	 Enter the low limit value for the alarm.

Count	 Defines the number of consecutive readings that must be 
below the Low alarm Limit before the alarm is triggered. 
Higher count values decrease the possibility that a tran-
sient or noise signal will trigger a false alarm.
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Low Warning 
When checked, enables the Low Warning alarm.

Name	 Enter a name for the alarm that will be used to identify the 
alarm to the system.

Value	 Enter the low limit value for the alarm. Must be higher than 
the Low alarm Warning value.

Count	 Defines the number of consecutive readings that must be 
below the Low alarm Warning before the alarm is trig-
gered. Higher Count values decrease the possibility that a 
transient or noise signal will trigger a false alarm.

Auto Set button 
When selected, this button automatically sets the alarm levels:

High Limit	 10 times the current scan value.

High Warning	 5 times the current scan value.

Low Warning	 5 times less than the current scan value.

Low Limit	 10 times less than the current scan value.

Action button 
Choose the Action button to view the Alarm Action dialog box, where 
you can specify what action the system should take when the specified 
alarm is set.

Figure 3-13. 
Alarm Action dialog box.
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Dialog Box 
Specify a message to display when the alarm is set.

Message	 Enter a message that will be displayed in the 
Alarm dialog box when the alarm is triggered.

Info File	 Enter the name and path of a help file or use the 
Browse button to navigate to the location of a 
help file (if available) and select the file.

	 This file will be launched when the user clicks 
the Information button in the Alarm message 
box that appears when an alarm is triggered. For 
example, the file could suggest troubleshooting 
action to take to correct the alarm.

Sound 
Enter the name and path of a sound file or use the Browse button to navi-
gate to the location of the sound files (included during the software install) 
and select a file. This allows you to include a warning sound (in addition to 
text instructions) to alert the operator when the alarm is triggered.

Test Dialog button 
Click this button to test the alarm. The Alarm message box will appear. 
Click Acknowledge or Disable to close this dialog box. The Information 
button is not currently available.

Figure 3-14. 
Alarm Action dialog box.
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Working with Data Files

Saving Data Files

Displayed information can be saved for later viewing or printing. Each data 
record within a data file contains scan data from the mode display window(s). 
Data records are created in serial format, as the data becomes available from 
the system. A Custom mode, for example, will save each display as a data 
record.

To save a data file:

1.	 Select the display window(s) for which data will be saved. 

•	 When selecting multiple display windows, hold down the Shift key 
and click on each window you wish to include.

•	 Click in the header area of a highlighted display window to deselect it.

•	 If no display windows are selected, the software saves data for all dis-
play windows in the mode.

2.	 Select Save Data from the File menu or click    on the Data File Tool-
bar to view the Save As dialog box.

	 Enter a name for the data file in the File name text field and save it in a 
folder using standard Windows techniques.

3.	 To stop saving data click   on the Data File Toolbar.

Figure 3-15. 
Save Data (Save As)  
dialog box.

File menuSaving
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Opening Data Files

To open a data file:

1.	 Click    on the Data File Toolbar.

2.	 Navigate to the location of the data file and select it.

3.	 Select Open. The data file appears on the screen. From here it can either be 
viewed or printed.

Scrolling Through Data Records

Select either Data File Position from the File menu or use the Data File Tool-
bar to scroll forward and backward through the data file using the standard 
recording symbols such as rewind or fast forward.

Converting Data Files

Use this utility to convert the analyzer Configurator Software data files into 
ASCII text.

1.	 Select Convert Data File from the File menu and select one or more data 
files.

2.	 Click Convert to convert and save the file with a CSV extension.

File menuOpen
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Printing Data

The Configurator Software will print scanning information in a format similar 
to how it is displayed on the screen using the display parameters created for 
that mode. You can view a preview of what will be printed by selecting Print 
Preview from the File menu.

In Custom mode, the system prints the currently selected display window. If 
you do not select a display window, the system prints information for each 
display window using the required number of pages.

To print data:

1.	 Select the display window(s) to be printed. If a window is not selected, the 
entire screen will be printed. To select multiple windows, hold down the 
Shift key while selecting each window.

2.	 Select Print from the File menu or click   .

3.	 Type a print-header comment in the Display Print dialog box. This infor-
mation appears in the title of the printed pages. Click OK.

4.	 If you select Print from the File menu, a standard Windows Print dialog 
box appears. Set the additional print information.

5.	 Click OK to print the scanning information.
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